National Marine Fisheries System

Electronic Reporting System
Version 2.1.8

User's Guide

FOR

VESSEL PROCESSOR

ELECTRONIC REPORTING SYSTEM

Table of Contents

3Introduction

System Requirements
3
Technical Support
3
How to obtain ER software
3
Installing the ER System
4
CD & 3.5" Disk installation..…………………………………………………………………………..4
Internet installations
5
uninstalling the er system software………………………………………………...……6

Starting the system
6
Main SCREEN……………………………………………………………………………………………...7

Weekly Production Report (WPR)
15

Transmitting Reports
18
Return Receipts
20
Exiting the software
20


Introduction

Throughout this manual this version of the “NMFS Electronic Reporting System” will be referred to simply as the “ER System V2”.  This distribution of ER System V2 is for vessel processors only.  A separate distribution of the ER System is available for shoreside processors. 

The ER System was developed by NMFS to allow processing vessels to submit Federal reports to NMFS by electronic means, as opposed to filling in blank forms and faxing them to Juneau.  While processing vessels are at sea, they can submit reports via e-mail or direct from a modem from their computer on board.  The ER System is intended to help processing vessels by making the reporting process simpler and more accurate.  The ER System also helps NMFS because the catch data from the processing vessels is automatically entered into the NMFS database.  This automatic data entry eliminates possible data entry errors when NMFS staff enters catch data into NMFS databases. 

Currently there is one type of report used with the processor vessel ER System V2:

Weekly Production Reports (WPRs)

WPRs contain weekly reporting on the species and amount of fish harvested and how the fish was processed. Data collected include target species, gear type, production type, discard species, weights, and reporting area.

System Requirements

The ER System V2 requires a computer running Windows 95, 98, NT, or compatible operating system.

· Electronic transmission of data files requires a modem or compatible device or a messaging system such as internet email or Inmarsat C.

Technical Support

If you encounter any problems installing the software or in using the system please call (907) 586-7085 and ask for electronic reporting technical support, or you can e-mail er.help@noaa.gov 

How to obtain ER software

NMFS will mail you an ER System V2 installation CD upon request.  Call the NMFS Juneau office at (907)586-7228, the NMFS Dutch Harbor office at (907)581-2062, or the NMFS Kodiak office at (907) 481-1781 to make arrangements to get an installation CD.  You can also download the ER system software from the NMFS homepage at www.fakr.noaa.gov. 

Installing the ER System V2 from CD


This software requires Windows95, 98 or WindowsNT, and is provided in Compact Disc (CD) format.

1)  Close all other applications.

2)  Make sure that you do not install a duplicate copy of ER System V2 on your machine.  If a previous installation has been done, it MUST be removed before you install again.  Please refer to the section on Uninstalling ER System Software.

However, ER System V2 may be installed on a computer with the previous version of ER software (Version 1.5).  You may wish to regain version 1.5 if you want to access 1998 or 1999 data that were entered with that version.

3)  Run the Setup.exe program from the ER Version 2 CD.  One way to locate and run this program is:

a) Click on the START button in the lower left corner of the screen, and highlight the PROGRAMS menu.

b) Choose “Windows NT Explorer” or “Windows Explorer” from the menu.

c) From the “Explorer” screen, click on “My Computer” in the top left side of the screen.

d) In the contents of “My Computer”, check to see which disk drive is labelled CD-ROM.

e) Place the NMFS Electronic Reporting System Vessel WPR CD-ROM in the CD drive of your computer, and close the CD drive door.

f) Click on the CD-ROM’s disk drive in the left hand side of your screen.  This will cause all the files on the CD-ROM to be listed on your screen.

g) Scroll down the list of files an double-click on a file named “setup.exe”.  This will start the installation procedure.

4) The first screen you see should be a reminder to exit all other software before

       attempting installation of ER.  Click OK.

5) You are prompted for your Alaska Federal Fisheries Permit Number.  Enter the 4 digit number that identifies your processor.  This number is found on your Federal fisheries or processor permit.

6) The next screen will request that your specify a destination directory for installing this software.  It is recommended that you accept the default directory of C:\Program Files\ER Client2\.  Click the big button to accept this default directory.

7) The next screen should say that the program has installed sucessfully,

8) To start up the ER System, push the START button in the lower left corner, click on PROGRAMS, and from the menu list under PROGRAMS, click on ER Client 2.

Installing the ER System from  the Internet

The NMFS Electronic Reporting client software can be downloaded from the Electronic Reporting Homepage ‘http://www.fakr.noaa.gov/nmfs_er/’.  

Steps to download the ER system:

1.   
Create a temporary folder (directory) named C:\ERTemp.  Files will be downloaded to this folder. 

2.  
Go to the Electronic Reporting screen at the NMFS Homepage: http://www.fakr.noaa.gov/nmfs_er/ 

3.  
There is a blue hypertext area to click:
ERV2Vess.EXE 
This will download the NMFS Electronic Reporting client software Version 2 for processor vessels.

Shoreside processors should download the file ERV2Elog.EXE

These are compressed, self-extracting files.

4.  
In MS Internet Explorer, the 'Save As' screen will appear.  Make certain that the ERTemp folder is selected.  You will have to select ERTemp yourself.  Then press Save.

6.  
After the software is downloaded, you need to decompress the files.  Run the self-extracting file by double-clicking on its name.  The files will extract to the same directory (ERTemp).

7.  
After the files are decompressed, you need to run the file ‘Setup.exe’, which is part of the ER software.  To run the file ‘Setup.exe’, click the Start button on the task bar, then press Run.  Type in:  C:\ERTemp\setup.exe  then press OK.  Follow steps 4-8 of the CD installation listed above. 

Uninstalling ER System Software

It may be necessary  to uninstall and re-install the ER System software.  Before uninstalling, make sure that you have a current backup of your ER database.  Check with NMFS to make sure that the data associated with your current ER System software will not be lost if you have any question about the correct procedures.

To uninstall the ER System Software, click on the START button in the lower left corner of your screen, then click on SETTINGS, CONTROL PANEL, and finally on ADD/REMOVE programs.  Follow the prompts to remove the entire ER System software.  After removing the ER System software, it is a good idea to look in the directory where it was previously installed and check to make sure that all of the files in that folder have been removed.  Now it is safe to re-install the ER System software in the same folder.

Starting the system

To start the ER System software click the Start button at the bottom left corner of the screen, then highlight Programs.  Click on the ‘ER Client 2’ item in the Programs list and the software will start. 

The first time you start the ER software the Login screen appears with “Admin” in the User field.  Initially, there is no password for “Admin”, simply press the ENTER key to continue.  If you choose not to implement password protection the Login screen will always open this way.  
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THE MAIN SCREEN

After you log in, the system opens the NMFS ELECTRONIC REPORTING CLIENT SCREEN, hereafter called MAIN SCREEN.  The MAIN SCREEN has 4 tabs:  “About”, “Database”, “Transmit”, and “Communication Settings”.  After you log in, the screen defaults to the “About” tab.  The 4 tabs are described below:

[image: image2.png]Pot Seltings

Selectthe port and

Com Por: [EANNE. baud rate values for
out e,
Baud rate: | 3500 ¥
Forcommrication wih
Data bits: | hd| the NMFS Host, data
tensfrsetings shoid
Baiy [Nore =] || begiin
Stoptits: |1 hd | ‘Hardware(RTS/CTS]
and Set TR ine i
Flow Contol o
¥ Hardware (RTS/CTS)
I Software XON/XOFF]
v Set DIR line high
= oK Carcel





‘About’ Tab:

Under the Current Report Type in the right-hand side of the screen, highlight “Contact Information” and click on “open Report”.  This screen contains basic information regarding your vessel.  The Name, Federal Permit #, and ADF&G Permit # should already have the correct values for your processing vessel typed in.  The other blank fields are Phone,  FAX, E-mail and Representative.  Please fill them in with your most current information.  It is important to enter this information and keep it up-to-date because the information shown on this screen is automatically entered in the header section of reports generated by this software.

‘Database’ Tab:

When you click on the DATABASE tab, you see the DATABASE screen.  This screen has several functions associated with the ER System databases.
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System Database and Client Database

Clicking on the “Database Button” shows the Database screen.  The top two boxes on the left allow you to specify where the electronic copies of the two Microsoft Access databases are stored.  These two databases are used together by the ER System software to store the information that you keypunch in the computer for your Weekly Processor Reports (WPRs).  Usually both the System Database and the Client Database are stored in the same folder (directory).

Password function

User names and passwords are optional in the ER software.  If you decide not to assign user names and passwords, then all users can login as user name “Admin” and do not use a password.  However, if you decide to use the user name/password function, the system administrator (whoever is responsible for maintaining the ER System) should be in charge of it.  The system administrator would take the user name “Admin” and create a password for the system administrator’s use.  The System Administrator would assign user names and passwords to each person using the ER System software.

To use the user name/password function, make sure you are in the DATABASE screen and click on the button “Edit Users/Passwords”.  You will see the following screen:
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There are two levels of permissions, Admin and User.  People with Admin rights have access to everything in the system.  They can change the information in the Client Settings screen or make changes to the communications settings.  They can also add to or change password combinations.  

People in the User category can only work on the NMFS reports (create, edit, revise, print, and transmit).  They do not have access to the Client Information screen and can’t change the communications settings of the system.  In addition they are not allowed access to the password function.  
There are two basic ways to use the password function:

1) Partial password system: assign user names only.  Any type of name can be assigned; first name only, first and last name, or a persons’ initials can be used.  No password is needed: when the login screen appears type in the user name and hit the ENTER key.


2) Combination user name and password system:  assign user names in combination with unique passwords.  The user must type in a valid user name as well as the password associated with that name.  


*note that passwords are case-sensitive (i.e.  if the password is entered as “Tom” then subsequent logins must be typed in exactly the same way, “tom” will not work).

To add a new user to the list click on the “New” button, and a New User screen will display.  The new user screen looks like this:
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After the New User has been entered, use the mouse pointer to choose the Group Membership by clicking on the check-box next to Admin or User.  New users must belong to at least one of the two groups, or can belong to both.

If you want to create a unique password for the new user, click on the New Password field.  Type in a password, any combination of characters and numbers can be used.  Type in the same password in the Verify field.  Click the mouse pointer on the Change button and a message appears stating the password has been changed successfully.   

Anyone with Admin rights can add new users, view the list of current users, and delete users from the list.  To delete a user from the list, use the mouse pointer to highlight the name and click on the Delete button.

‘BACKUP’, ‘RESTORE’, ‘COMPACT’ and ‘MIGRATE’ Buttons:

BACKUP button.  The BACKUP button allows you to save a copy of your current data in Microsoft Access format to a location that you specify.  Ideally, you would backup your data to a floppy disk, ZIP drive, or other format that is removable from your computer.  That way, if your computer is damaged, you still have your data safely saved.  Daily backup of your data is recommended.

RESTORE button.  The Restore button allows you to get a previously backed-up copy of your data and overwrite it to your current ER System software.  For example, if you kept your ER System software on the hard disk in your computer, and your data was backed-up on a floppy disk drive, and the hard dish failed - you would lose your ER System software.  You could then purchase and install a new hard disk drive and re-install the ER System software, and use the restore button to get the backed up copy of your data from your floppy disk.

COMPACT button.  The COMPACT button uses a Microsoft Access database function that compacts the data so less space is used in electronic storage.

MIGRATE button.  This will be used to move data from a previous ER V2 installation into a new database if the software is upgraded.

‘TRANSMIT’ Tab:

Clicking on the TRANSMIT tab on the MAIN PAGE allows you to select the transmission method: internet e-mail, modem-to-modem, or export to file and send via e-mail.

The TRANSMIT screen looks like this:
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The 4 buttons at the bottom of the TRANSMIT screen are Transmit Reports, View Transmission Report, Process Return Receipts, and Send test Message. 

Transmit Reports.  Clicking the Transmit Reports button will transmit any new report or any report that has been modified.  You cannot choose which reports to transmit.  All available reports will be transmitted automatically.

View Transmission Report.  Clicking the View Transmission Report button will show a list of reports that have been transmitted along with the transmission history.  You can choose one of the reports and view its associated information.

Process Return Receipts.  Clicking the Process Return Receipts button will locate any recently received transmission reports that have arrived from NMFS and the ER System will update the Transmission Report to show which reports that have been transmitted to NMFS have been received.

Send Test Message.  Clicking the Send Test Message button will test whether the internet, modem or e-mail transmission method is working.  You will receive a return receipt from NMFS if the 2-way connection is working.

‘COMMUNICATIONS SETTINGS’ Tab

Clicking the COMMUNICATIONS SETTINGS tab in the MAIN MENU shows the screen below.  This screen allows the user to specify the computer’s settings so that the chosen transmission method will work.  These communication settings and basic communications functions are normally established automatically during the first-time installation of the software.  

There are 3 ways to transmit the WPR information to NMFS:  through internet e-mail, direct modem connection to NMFS, and create a file and attach it to an e-mail using your own e-mail software.
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Internet Settings

To transmit the WPR information to NMFS by internet e-mail, you need to type in the SMTP Mail Host name in the blank space provided.  The SMTP Mail Host name is the name of the computer that provides the internet e-mail service.  Next, enter the Return E-Mail Address.  This is your e-mail address at your internet e-mail service provider.  A common internet e-mail service provider is America On Line (AOL).

Modem to Modem Settings

Under this heading there are 4 buttons:  Port Settings, Modem Settings, Phone Numbers, and Advanced buttons.  All 4 of these buttons are necessary to configure your modem so that it works correctly.  Some of the information you need to fill in this information can be obtained from the modem’s documentation.  You can also use the Windows Control Panel to view the current hardware installed on your system, which includes the some modem information.

Step 1. Choose the Port Settings button. On the Port Settings screen, set the port number and baud settings.  Accept defaults on all others.  (Windows Control Panel has port number and baud settings information)
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Step 2.  Choose the Modem Settings button.  Choose the modem make and model.  If you don't find your model, select one that is similar to yours, or try 'Hayes compatible'.  If modem setup is successful, you will see a "Modem initialized" screen.
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Step 3.  Choose the Phone List button.  This is where vessel-specific prefix's and suffix's to the basic phone number are entered.  Every vessel and shoreside processor will need to inspect this screen on first time modem setup and make sure that the entire modem dial string is correct for their location, such as area code, number to get out of local PBX, and satellite hardware strings.
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Step 4.  Choose the Advanced  button.  This is where the communications settings for the modem are set.  
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Warning!  Settings on this Communications Settings screen should not be modified without the guidance of NMFS technical support.  This screen is for customizing transmission settings in case the modem can't be setup successfully using the other modem to modem settings buttons.
Vessel Processor WPRs

To create a new WPR:

· Choose 'Vessel Weekly Production Report' from the heading ‘Current Report Type” in the Main Menu.  

· Press the ‘Open Report’ button at the bottom of the page.

· Press the ‘New WPR’ button at the bottom of the page.  

Weekly Production Reports are summaries of a processing vessel’s activities for a given week.  With the exception of January 1 and December 31, weekly reporting periods start at 0001 hours Sunday morning and end at 2400 hours (midnight) on Saturday.  When choosing a date for the WPR you need to choose a valid week ending date (i.e.  a Saturday).

Vessel Processor WPR

Report view

WPR’s are made up of two separate elements; a master report (called the Report View) and worksheets (Worksheet View). Worksheets contain the bulk of the WPR data and include the Week Ending Date, Gear Type, and Product and Discard information. A completed WPR will contain one report view as well as one or more worksheets.  A new WPR opens up in the Report view.  

Some vessels operate as both 'catcher processor' and as 'mothership'. If you change the Vessel Type in the Client Settings screen, all subsequent reports will default to the changed type. Verify that the Vessel Type is correct for the current week’s operations and enter the number of crew.

Fish Tickets

ADF&G Fish Tickets are voluntary for catcher/processors and are required of motherships.  The format for fish tickets is a series number and year, followed by a six digit number.  An example of a series G groundfish ticket is: G97000441.  Note that if you try to enter this as number 441 in the ER software the number will be rejected.

This is what the Report View looks like:
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The Report View screen contains the Fish Ticket data.  If you need to enter a series of consecutive fish tickets you can save time by entering in a range of fish ticket numbers.  To enter a range of numbers:

· Choose Fish Ticket Range from the Edit menu

· In the “From” box enter the beginning fish ticket number

· In the “To” box enter the last fish ticket number

· Hit the OK button   


Notice the Products button to the left of the Close button in the Report View screen.  It is dimmed because no worksheets have been created for this report.  If there are worksheets, the Products button would be bold and could be used to toggle to the worksheets.  If no worksheets have been created, you need to click the mouse pointer on the “New Worksheet” icon on the toolbar, or choose “New Worksheet” from the File menu on the menu bar.  

Data entry starts in the Week End Date field and moves from left-to-right, top-to-bottom.  Any field with an arrow next to it contains a drop-down list that can be used to fill in the field’s value.  

Worksheet View

Weekly production reports are designed to allow one report to have data from multiple areas (or gear types).  A single WPR can contain multiple worksheets for weeks when you fish in different areas or change gear type (or go from open access fishing to CDQ operations).  When more than one worksheet is present, the box at the bottom of the screen will indicate which worksheet is visible.  One worksheet overlays the other, so that only one worksheet is visible at a time.  To create additional worksheets click the mouse pointer on the “New Worksheet” icon on the toolbar, or choose “New Worksheet” from the File menu on the menu bar. 
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Enter the Federal reporting area, and Gear type.  Enter the appropriate Special Area code if you are fishing in the COBLZ (C. opilio crab bycatch limitation zone) or the Red King Crab Savings Area (RKCSA).  Consult your logbook reference manual for the special area coordinates.

If you are fishing in the CDQ fishery or under an experimental or research permit, select the appropriate code under Management Program.  Use the down arrow and select the program or type in the first letter of the appropriate program and the system will fill in the rest. If you are not fishing in one of the listed Management Programs then leave this box and the Account/Permit # box blank.   If you are fishing in a listed program enter the ‘Account/Permit’ number ( e.g. IFQ permit number, CDQ group number (51…56), AFA inshore Coop number (101…108)).

Enter the species code of your primary and secondary groundfish target species for the CURRENT week only.

Product Tab

The worksheet data entry section is divided into two Tabs (these are like folders): Product and Discard.  The Product tab is the default tab.  When activated “Products” will be a bold font and a line appears below the Product Tab that’s formatted for product data.  After the first line of data has been entered you create the next line by hitting the TAB key or clicking on the asterisk below the first line.

Discard Tab

To change to Discard data entry, click on the Discard Tab.  Notice that “Discard” is in bold and “Products” is in regular text.
To move from the Worksheet View to the Report View, click on the Fish Ticket button at the bottom of the screen.     

Transmitting Reports

A report’s status may be one of ‘Open', ‘Queued', ‘Sent', or ‘Received'.  An open, or current report is one that has been created in the client application but has never been transmitted to the NMFS.  You can freely edit or delete an open report until the report is transmitted. 

Transmission Queue

In order to transmit a report, you must put the report in the transmission queue.  There are two ways to put the report in the transmission queue.  First, by checking the 'Transmit' check box in the report screen, as seen below:
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A second way to queue a report is in the 'View Transmission Report’ button on the Transmit tab of the Main Screen, by checking the Transmit box as you can see below.
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Both actions have the effect of setting the report’s status to ‘Queued’.  A queued report may continue to be edited just like an open report up until the time that the next transmission actually takes place.  A report may also be easily removed from the transmission queue by unchecking the Transmit box:  in effect changing its status back to ‘Open’.

When a transmission actually takes place, all the reports whose status is ‘Queued’ are exported to the transmission data file, and the file is transmitted to the NMFS host.  If the transmission is successful, all queued reports then have their status changed to ‘Sent’.  Once sent, a report can no longer be edited in the client application.  In order to change the data on a sent report, the user must create a revision of the report and transmit the revision to NMFS.  When a revision is created, a new, open report is created, (with the report number and all the data from the old report).  The steps for editing, queuing, and sending the revision are the same as for any other new report.

Return Receipts

After reports have been transmitted and received successfully by the by the NMFS host system, a return receipt will be generated and sent to the vessel processor to acknowledge receipt of the report.  These return receipts are stored until you use the ‘Process Return Receipts’ button in the Transmit tab of the MAIN PAGE.  At that time, your ER System will mark the appropriate reports as ‘received’, and they will no longer be sent when the ‘Transmit’ button is pressed.  

It is important to process return receipts upon receiving them from NMFS by using the ‘Process Return Receipts’ button to keep your databases up to date.  If you do not keep your databases up to date with the most current return receipts from NMFS, you will be creating unnecessarily large transmission files.  This happens  because each time reports are transmitted, the transmission file will automatically include all reports with the status of  ‘Queued’ and ‘Sent’.  If their status is changed to 'Received' they will not be included in the transmission file.
Exiting the software

To exit the ER software and return to Windows either:

1) Return to the MAIN PAGE, and press the EXIT button in the bottom center of the screen.  You will immediately exit the program and return to Windows.

2) In the Report View screen, click on the ‘File’ menu in the upper left corner of the screen and choose Exit from the menu.  You will be prompted by a question as to whether you want to exit.  Choose ‘Yes’ and you will exit the program.
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